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About this document 

Scope and purpose 

AN215656は、Arm® Cortex®-M4, Cortex-M0+ CPU, およびプロセッサ間通信 (IPC) モジュールを含む PSoC 6 
MCUのデュアル CPUアーキテクチャについて説明します。デュアル CPUアーキテクチャは、システム
性能を向上させ効果的に動作し、消費電力も削減します。また、本アプリケーションノートではサイプ
レスの ModusToolbox®ソフトウェア、Command-line Interface (CLI)、および PSoC Creator IDEを使用して
シンプルなデュアル CPU設計のビルド方法と、様々な IDEを用いた設計のデバッグ方法も説明します。 
 

関連製品ファミリ 

デュアル CPUを備えるすべての PSoC® 6 MCUデバイス 

関連サンプルコード 

CE216795 

関連アプリケーションノート 

関連資料を参照してください 
 

さらにサンプル コードをお求めでしょうか？以下の通り対応いたします。 

PSoCサンプル コードのリストにアクセスするには、サンプル コードのウェブページをご覧ください。 
サイプレス ビデオ トレーニング ライブラリについてはここからご覧ください。 
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1 はじめに 
PSoC 6 MCUは、IoT専用に設計されたサイプレスの超低消費電力 32ビット PSoCです。これには低消費
電力フラッシュと SRAMテクノロジ、プログラマブル デジタル ロジック、プログラマブル アナログ、
高性能アナログデジタル変換、低消費電力コンパレータおよび標準の通信機能とタイミング ペリフェラ
ルを内蔵します。 

PSoC 6 MCUの主な部分は CPUサブシステムです。Figure 1に示すように、このアーキテクチャは複数の
バス マスタ (2つの CPU、DMAコントローラーや暗号化ブロック (Crypto)) が組み込まれます。 
 

PSoC 6 CPU Subsystem

System Interconnect: Multi-Layer Advanced High-performance Bus (AHB), Inter-Processor Communication (IPC)

ROM DataWire/
DMA CryptoCortex M0+

Peripheral Interconnect

FlashCortex M4,
with FPU SRAM DataWire/

DMA

 

Figure 1 PSoC 6 MCUの標準 CPUサブシステム アーキテクチャ 

Note: Figure 1のブロック図の内容は、デバイスによって異なります。PSoC 6 MCUの一部の製品
にはアプリケーションで使用できる CPUが 1つしかありません。詳細についてはデバイ
スデータシートをご覧ください。このアプリケーションノートはシングル CPU PSoC 6 
MCUデバイスには適用されません。 

一般的に、すべてのメモリとペリフェラルはすべてのバス マスタによって共有されます。共有リソース
は、標準 Armマルチレイヤ バス アービトレーションを介してアクセスされます。排他的アクセスは、
ハードウェアにセマフォと相互排除 (mutex) を実装するプロセッサ間通信 (IPC) ブロックによってサポー
トされます。 

DMAおよび暗号化 (Crypto) バス マスタを含むデュアル CPUアーキテクチャは、シングル MCUでシステ
ム レベルの設計と性能最適化に比較すると比類がない能力を提供します。2つの CPUは以下を与えま
す。 

• 複数タスク同時実行の CPUタスク割当て 
• CPUにリソースを割当て、CPUがこれらのリソース管理に専念して効率を向上させる 
• 消費電力を最小限にするために CPUを有効／無効にする 
• IPCブロックを使用し、CPU間でデータ送信する詳細はサンプル コード「CE216795、PSoC 6 MCU 

Dual-CPU Basics」を参照してください。 

アプリケーションの 1例では、Cortex-M0+ CPU (CM0+) は、すべての通信チャネルを「所有」し管理しま
す。Cortex-M4 CPU (CM4) は、CM0+経由でチャネルからメッセージを送受信できます。これにより、
CM0+が通信を管理している間、CM4は開放され他のタスクが実行できます。 

1.1 ツールとライブラリ 
サイプレスは、PSoC 6 MCUを使用したアプリケーション開発に使用できる 2つの開発プラットフォーム
を提供します。 

http://www.cypress.com/search/all?f%5B0%5D=meta_type%3Atechnical_documents&f%5B1%5D=resource_meta_type%3A575&f%5B2%5D=field_related_products%3A114026
http://www.cypress.com/search/all?f%5B0%5D=meta_type%3Atechnical_documents&f%5B1%5D=resource_meta_type%3A575&f%5B2%5D=field_related_products%3A114026
http://www.cypress.com/ce216795
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• ModusToolbox: ModusToolboxソフトウェアには、構成ツール、低レベルドライバー、ミドルウェア
ライブラリ、オペレーティングシステムのサポート、および MCUとワイヤレスアプリケーションの
作成を可能にするその他のパッケージが含まれます。また、ModusToolbox用のオプションの Eclipse 
IDEも含まれます。 

• PSoC Creator: Windowsでのみ実行されるサイプレス独自の IDE。これは、PSoC 6 MCUデバイスのサ
ブセットと、PSoC 3、PSoC 4、PSoC 5LPなどの他の PSoCデバイスファミリをサポートします。 

どちらのプラットフォームも、Keil μVision、IAR Embedded Workbench、Visual Studio Codeなどのサード
パーティツールにプロジェクトをエクスポートするメカニズムを提供します。 

サイプレスは、PSoC 6 MCUを使用したアプリケーション開発を容易にする一連のライブラリも提供しま
す。 

• Peripheral Driver Library (PDL): PDLドライバは、ハードウェア関数を使いやすい APIのセットに抽象
化します。PDLの詳細については、https://github.com/cypresssemiconductorco/psoc6pdlの Webペ
ージにアクセスしてください。このライブラリは、PSoC Creatorおよび ModusToolboxソフトウェア
で利用できます。 

• Hardware Abstraction Layer (HAL): HALは PDLの上に構築されます。サイプレス MCUでハードウェア
ブロックを構成および使用するための高レベルのインターフェースを提供します。これは、複数の製
品ファミリで使用できる汎用インターフェースです。HALの詳細については、
https://github.com/cypresssemiconductorco/psoc6halの Webページにアクセスしてください。HAL
は ModusToolboxソフトウェアで利用可能であり、CM4 CPUでのみ機能します。PSoC Creatorは HAL
をサポートしません。 

• Middleware: このカテゴリには、静電容量センシングや HTTPサーバーなど、さまざまなドメインの
APIを実装する複数のライブラリが含まれます。ミドルウェアライブラリは、サイプレスによって作
成されるか、サードパーティから提供される場合があります。PSoC Creatorでは、ミドルウェアは通
常、PSoC Creatorコンポーネントとして利用できます。ModusToolboxソフトウェアでは、ライブラ
リとして利用できます。 

• Board Support Package (BSP): BSPは、ボードの機能への標準インターフェースを提供します。API
は、サイプレスキット全体で一貫しています。他のソフトウェア (ミドルウェアやアプリケーション
など) は、BSPを使用してハードウェアを設定および制御できます。BSPは、ModusToolboxソフトウ
ェアでのみ使用できます。 

1.2 この文書の使い方 
本文書では、PSoC 6 MCUアーキテクチャおよびサイプレスの ModusToolboxソフトウェアまたは PSoC 
Creator IDEを使用した PSoCデバイス用アプリケーション開発に精通されていることを前提とします。
PSoC 6 MCUの説明は、下記を参照してください。 

• PSoC 6 MCUデバイスデータシート 
• AN221774, Getting Started with PSoC 6 MCU 
• AN210781, Getting Started with PSoC 6 MCU with Bluetooth Low Energy (Bluetooth LE) Connectivity 

ModusToolboxソフトウェアを初めて使用する場合は、ModusToolboxソフトウェアのホームページを
参照してください。 一部の PSoC 6 MCUデバイスは PSoC Creatorでサポートされません。この場合、
ModusToolboxソフトウェアを使用する必要があります。ModusToolboxソフトウェアを使用する場合
は、デュアル CPUを搭載した PSoC 6 MCUデバイスに基づく設計では、バージョン 2.2以降であること
を確認してください。 

PSoC Creatorを初めて使用する場合は、PSoC Creatorのホームページを参照してください。 PSoC 6 MCU
ベースの設計には PSoC Creatorバージョン 4.3以降を使用してください。 

https://github.com/cypresssemiconductorco/psoc6pdl
https://github.com/cypresssemiconductorco/psoc6hal
http://www.cypress.com/search/all?f%5B0%5D=meta_type%3Atechnical_documents&f%5B1%5D=resource_meta_type%3A575&f%5B2%5D=field_related_products%3A114026
http://www.cypress.com/an221774
http://www.cypress.com/an210781
http://www.cypress.com/products/modustoolbox-software-environment
http://www.cypress.com/products/psoc-creator-integrated-design-environment-ide
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本アプリケーション ノートの最初の節では、デュアル CPU MCUの一般的なコンセプトと、それらを
PSoC 6 MCUに実装方法について説明します。PSoC 6デュアル CPU MCUのための ModusToolboxソフト
ウェアまたは PSoC Creatorプロジェクトの作成概要にスキップするためには、PSoC 6 MCUデュアル
CPUでの開発プロセスを参照してください。 
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2 一般的なデュアル CPUのコンセプト 
デュアル CPU MCUのファームウェア開発プロセスは、1つではなく 2つの CPUのコードを記述する点
を除いてシングル CPU MCUの場合と同じです。また、プロセッサ間通信の必要性も考慮する必要があ
ります。 

• パフォーマンス: 2つの CPUを持つ主な利点は、本質的に CPU性能と帯域幅を増やすことです。
PSoC 6 MCUでは、その増加した帯域幅はシングル CPU MCUと同程度の価格で提供されます。増加し
た帯域幅の使用方法については、アプリケーションが実行するタスクに依存します。 

• シングル タスクの場合: アプリケーションが大規模で複雑な場合を除いてシングル タスク アプリケ
ーションはデュアル CPU MCUには適しません。ただし、PSoC 6 MCUでは 1つの CPUでタスクを実行
し、もう片方の CPUをスリープさせて消費電力を削減できます。 

• デュアル タスクの場合: 最も有用で、タスクごとに CPUを割り当てます。より大きなコンピューテ
ィング要件のタスクを高性能 CPUに割当てます (例えば PSoC 6 MCUの Cortex-M4 (CM4) CPU)。 

• マルチ タスクの場合: 各タスクを CPUに割り当てます。各 CPUでは、タイムリーに各タスクを実行
するためのメソッドを含む必要があります。 

• RTOS: 複雑なマルチタスク システムは、リアルタイム オペレーティング システム (RTOS) によって管
理できます。基本的に RTOSは、タスク優先順位やタスクがイベントを待つかどうかによって、各タ
スクにいくつかの CPUサイクルを割り当てます。CPUにタスクを割り当てることで、効果的に自身
を実行できます。デュアル CPU RTOSアーキテクチャの例は以下のとおりです。 
− 各 CPUは所有の RTOSとタスクの独自セットを持ちます。各 RTOSには、他の CPUとの通信を管
理するタスクを持ちます。 

− 1つの CPUだけが RTOSと複数のタスクを持ちます。他の CPUは、指定するタスクを実行するよ
う知らされるまでアイドル状態になります。それからウェイク アップし、タスクを実行してその結果を
最初の CPUに戻します。例として、PSoC 6 MCUの低性能 CPU CM0+は、PSoC 6 MCUの高性能 CPU 
CM4を使用して、必要なときに高い計算要件のタスクを実行できます。 

• 消費電力: デュアル CPUシステムでは、ファームウェアは CPUの起動と停止を行い、消費電力を調
整します。前の例では、消費電力を減らすために、高性能 CPUは、負荷が高い計算動作が必要とな
るまでスリープ状態になります。 

• デバッグ: 同時に 2つのコード分をデバッグするのは複雑な作業です。通常は一方の CPUコードをデ
バッグしてから、もう一方の CPUコードをデバッグします。さらにオシロスコープやロジック アナ
ライザなどのデバイスは、CPU間通信を監視するのに使用できます。 
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3 PSoC 6 MCUデュアル CPUアーキテクチャ 
ページ 2の Figure 1に、PSoC 6 MCUのデュアル CPUアーキテクチャの概要を示します。(PSoC 6 MCUの
詳細ブロック図については、デバイスのデータシートまたは AN221774を参照してください。) ここで
はデュアル CPUに関連する特定の機能やその他の詳細について説明します。詳細は Arm documentation 
sets for Cortex-M4と Cortex-M0+および PSoCデバイスのテクニカル リファレンス マニュアル (TRM)を
参照してください。 

• CPU: 両方の CPU (Cortex-M4と Cortex-M0+) は 32ビットです。CM4は最大 150MHzで動作し、浮動小
数点ユニット (FPU) を備えます。CM0+は最大 100MHzで動作します。 
CM4はメイン CPUです。割込み応答時間が短く、コード密度が高く、そしてスループットが高く設
計されています。CM0+ CPUはセカンダリです。PSoC 6 MCUでシステム コールとデバイス レベルの
セキュリティ、安全性、および保護機能を実装するために使用されます。また、CM0+は Bluetooth LE
通信や CapSenseなどの機能にも推奨されます。 

• パフォーマンス: 通常、CM0+は CM4よりも低速なクロック速度動作です。CM0+命令セットは、CM4
命令セットよりも制限されます。したがって、CM0+に機能を実装するためにより多くのサイクルが
必要となり、サイクル時間が長くなります。どの CPUにタスクを割当てるかを決めるときは、これ
を考慮してください。 

• セキュリティ: PSoC 6 MCUは、いくつかのセキュリティ機能を備えます。詳細は TRMを参照してく
ださい。セキュリティ要件を満たすために、CM0+は「セキュア CPU」として使用されます。これに
は、信頼できるエンティティとみなされ、サイプレスのシステム コードとアプリケーション コード
を実行します。システムおよびセキュリティ タスクに CM0+の使用では、ユーザー アプリケーション
へのその可用性が制限される恐れがあります。セキュア システムの詳細は AN221111 - Creating a 
Secure Systemを参照してください。 
デバイス システム コールはいずれかの CPUによって起動されますが、常に CM0+によって実行され
ます。 

• 起動 シーケンス: デバイスがリセットされた後、CM0+のみが動作し、CM4はリセット状態に保持さ
れます。CM0+は、SROMコード、FlashBootおよびセキュア イメージを含むサイプレス システムとセ
キュリティ コードを最初に実行します。これらのコード モジュールの詳細は、アーキテクチャ TRM
の Boot Code章を参照してください。 
CM0+がシステム コードとセキュリティ コードを実行した後、アプリケーション コードを実行しま
す。その時、CM0+は CM4のリセットを解除し、CM4はそのアプリケーション コードの実行を開始し
ます。PSoC Creatorは、CM4のリセットを解除するために CM0+の main() にコードを自動生成しま
す。ModusToolboxソフトウェアは、CM0+のデフォルトで空のプロジェクトを作成します。 

• プロセッサ間通信 (IPC): IPCは CPU間の通信と動作同期のために機能します。IPCハードウェアは、
IPCチャネル機能および IPC割込み用レジスタ構造を含みます。IPCチャネル レジスタは、相互排除 
(mutex) ロックおよび解放メカニズムおよび CPU間のメッセージングを実装します。IPC割込みレジ
スタは、メッセージング イベント、ロック イベントおよびリリース イベントで両方の CPUに割込み
を生成します 

• 割込み: 各 SPUはそれぞれ独自の割込みセットを持ちます。すべてのペリフェラル割込みラインは、
特定の CM4割込み入力に配線されています。ペリフェラル割込みは CM0+の 8個の割込み入力の限定
されたセット (CY8C61x7、CY8C62x7、および CY8C63x7の 32の割込み入力) にも多重化されます。割

込み割当ての検討事項を参照してください。 
• 消費電力モード: PSoC 6 MCUには、システム全体または単一の CPUに影響を与える可能性があるい
くつかの電力モードがあります。 Armの定義に従って、CPUの電力モードはアクティブ, スリープ, お
よびディープスリープです。デバイスシステムの電力モードは、LP, ULP, ディープスリープ, およびハ
イバネートです。 

http://www.cypress.com/an221774
https://developer.arm.com/products/processors/cortex-m/cortex-m4
https://developer.arm.com/products/processors/cortex-m/cortex-m4
https://developer.arm.com/products/processors/cortex-m/cortex-m0-plus
http://www.cypress.com/search/all?f%5b0%5d=meta_type%3Atechnical_documents&f%5b1%5d=field_related_products%3A114026&f%5b2%5d=resource_meta_type%3A583
http://www.cypress.com/search/all?f%5b0%5d=meta_type%3Atechnical_documents&f%5b1%5d=field_related_products%3A114026&f%5b2%5d=resource_meta_type%3A583
http://www.cypress.com/an221111
http://www.cypress.com/an221111
http://www.cypress.com/search/all?f%5b0%5d=meta_type%3Atechnical_documents&f%5b1%5d=field_related_products%3A114026&f%5b2%5d=resource_meta_type%3A583
http://www.cypress.com/search/all?f%5b0%5d=meta_type%3Atechnical_documents&f%5b1%5d=field_related_products%3A114026&f%5b2%5d=resource_meta_type%3A583
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− システム低電力(LP)モードは、リセット後のデバイスのデフォルトの動作モードです。最高のパフ
ォーマンスを発揮します。システム LPモードでは、CPUは Arm定義のモードのいずれでも動作し
ます。 

− システムの超低消費電力(ULP)モードは LPモードと同じで、より低いシステム電流を達成するた
めに性能のトレードオフがあります。このトレードオフはコア動作電圧を下げるため、動作クロ
ック周波数を下げ、高周波クロックソースを制限する必要があります。 システム ULPモードで
は、CPUは Arm定義モードのいずれでも動作します。 

− システムディープスリープモードでは、すべての高速クロックソースはオフです。 これにより、
両方の CPUが停止し、高速周辺機器が使用できなくなります。 ただし、ファームウェアによって
設定され有効になっている場合、低速クロックソースとペリフェラルは引き続き動作します。 こ
れらの周辺機器からの割込みにより、デバイスはシステム LPまたは ULPモードに戻り、1つ以上
の CPUがアクティブモードにウェイクアップします。 各 CPUには、CPUをウェイクアップするた
めのウェイクアップ割込みコントローラー(WIC)があります。 

− システムハイバネートモードは、デバイスの最低電力モードです。休止状態になる可能性のあるア
プリケーションを対象とします。デバイスは、ハイバネートからのウェイクアップ時にリセット
を受けます。起動 シーケンスを参照してください。 

− CPUアクティブモードでは、CPUがコードを実行し、すべてのロジックとメモリに電力が供給さ
れます。 デバイスはシステム LPまたは ULPモードである必要があります。 

− CPUスリープモードでは、CPUクロックはオフになり、CPUはコードの実行を停止します。デバ
イスはシステム LPまたは ULPモードである必要があります。 

− CPUディープスリープモードでは、CPUはデバイスにシステムディープスリープモードへの移行
を要求します。デバイスの準備が整うと、システムディープスリープモードに入ります。PSoC 6 
MCUでは、システムがディープスリープに移行する前に両方の CPUが CPUディープスリープに入
る必要があります。1つの CPUだけが CPUディープスリープモードに入った場合、システムは LP
または ULPモードのままです。 

PSoC 6 MCUの消費電力モード詳細は AN219528 - PSoC 6 MCU Low-Power Modes and Power Reduction 
Techniquesを参照してください。 

• デバッグ: PSoC 6 MCUは、デバイス プログラミングおよびデバッグのインターフェースとして動作す
るデバッグ アクセス ポート (DAP) を備えます。外部プログラマまたはデバッガ (「ホスト」) は、デ
バイスのシリアル ワイヤ デバッグ (SWD) またはジョイント テスト アクション グループ (JTAG) イン
ターフェースを介して DAPと通信します。DAPの使用で (デバイスのセキュリティ制限に従う)、ホス
トはデバイスのメモリとペリフェラルおよび両方の CPUのレジスタにアクセスできます。 
各 CPUは、次のようないくつかのデバッグ機能とトレース機能を提供します。 
− CM4はシングル ワイヤ出力 (SWO) ピン経由で、6つのハードウェア ブレークポイント、4つのウ
ォッチ ポイント、4ビット組込みトレース マクロセル (ETM)、シリアル ワイヤ ビューア (SWV) お
よび printf()スタイルのデバッグをサポートします。 

− CM0+は 4つのハードウェア ブレークポイントと 2つのウォッチ ポイントをサポートし、4KB専用
RAMを備えたマイクロ トレース バッファ (MTB) をサポートします。 

PSoC 6 MCUは、両方の CPUの同期デバッグとトレースのための Embedded Cross Triggerもあります。 

ModusToolboxソフトウェアといくつかのサードパーティ製 IDEはデュアル CPUデバッグをサポートし
ます。デバッグに関する考慮事項を参照してください。PSoC Creatorは一度に 1つの CPU (CM4または
CM0+) のデバッグに対応します。 

http://www.cypress.com/an219528
http://www.cypress.com/an219528
https://developer.arm.com/docs/ddi0314/latest/embedded-cross-trigger
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4 PSoC 6 MCUデュアル CPUでの開発プロセス 
ここでは、PSoC 6 MCUデュアル CPUデバイスに固有の開発側面についてのみ説明します。PSoC 6 MCU, 
ModusToolboxソフトウェア, または PSoC Creatorの詳細については、以下の 1つないしそれ以上を参照
ください。 

• AN221774, Getting Started with PSoC 6 MCU 
• AN210781, Getting Started with PSoC 6 MCU with Bluetooth Low Energy (Bluetooth LE) Connectivity 
• ModusToolbox ソフトウェアホームページ。 一部の PSoC 6 MCUデバイスは PSoC Creatorによってサ
ポートされません。この場合、ModusToolboxソフトウェアを使用する必要があります。
ModusToolboxソフトウェアを使用する場合は、デュアル CPUを搭載した PSoC 6 MCUデバイスベー
スの設計で、バージョン 2.2以降であることを確認してください。 

• PSoC Creatorホームページ。 PSoC 6 MCUベースの設計には PSoC Creatorバージョン 4.3以降を使用
してください。 

4.1 ModusToolboxソフトウェアの説明 
PSoC 6 MCUデュアル CPUデバイス用の ModusToolboxソフトウェアアプリケーション開発は、
ModusToolboxソフトウェアでサポートされる他のデバイス用のそれと似ています。デフォルトでは、
ModusToolboxソフトウェアに付属するボードサポートパッケージ (BSP) は、いくつかのビルド済み
CM0+アプリケーションイメージを提供します。ここでは、ビルド済みのイメージの代わりに独自の
CM0+アプリケーションを作成する方法について説明します。 

デュアル CPUワークスペースを作成するには、CM0+ CPU用と CM4 CPU用の 2つの新しいアプリケーシ
ョンを作成する必要があります。または、デュアル CPUサンプルコードに基づいて新しいプロジェクト
も作成できます。このサンプルコードでは、両方のアプリケーションが既にセットアップされていま
す。開始点として「dual-cpu」を含むリポジトリ名を持つ任意のサンプルコードを使用できます。こち
らのリストを参照してください。 

次のセクションでは、デュアル CPUワークスペースを作成する方法を段階的に示します。 

各セクションでは、ModusToolboxソフトウェアで異なるツールを使用する 2つの方法について説明し
ます。 

• ModusToolbox用の Eclipse IDE 
• コマンドラインインターフェース (CLI) 

4.1.1 CM0+ CPUアプリケーションの作成 

4.1.1.1 ModusToolbox 用の Eclipse IDE の場合 
1. クイックパネルで New Applicationをクリックしてください。次に、Figure 2に示すように、PSoC 6 

BSPの 1つを選択してください。 

http://www.cypress.com/an221774
http://www.cypress.com/an210781
http://www.cypress.com/products/modustoolbox-software-environment
http://www.cypress.com/products/psoc-creator-integrated-design-environment-ide
https://github.com/cypresssemiconductorco?q=psoc6-dual-cpu&type=&language=
https://github.com/cypresssemiconductorco?q=psoc6-dual-cpu&type=&language=
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Figure 2 ModusToolboxソフトウェアでのボードサポートパッケージの選択 

2. Nextをクリックして、Empty PSoC6 Appを選択してください。Figure 3に示すように、New 
Application Nameで「cm0p_app」に設定してください。New Application ダイアログに入力すると、
選択したワークスペースに新しいアプリケーションが作成されます。 

 



  

 

Application Note 11 of 49 002-23479 Rev. *B  
  2021-05-17
  

PSoC 6 MCU デュアル CPUシステム設計 
  
PSoC 6 MCUデュアル CPUでの開発プロセス 

  

 

 

Figure 3 CM0+ CPUアプリケーションの作成 

4.1.1.2 CLIの場合 
1. CLIターミナルを開き、プロジェクト作成用の ModusToolboxソフトウェアインストールフォルダ 

(<install_path>ModusToolbox/tools_<version>/project-creator/) に移動してください。 
2. project-creator-cliコマンドを実行して、新しいプロジェクトを作成してください。 

例: 

project-creator-cli \ 

 --board-id CY8CPROTO-062-4343W \ 

 --app-id mtb-example-psoc6-empty-app \ 

 --user-app-name cm0p_app \ 

 --target-dir “C:/workspace_directory” 

または、同じフォルダで project-creatorツールを実行し、ModusToolbox用の Eclipse IDEの場合で説明
したのと同じ手順でも実行できます。 

詳細については、ModusToolbox User Guide (セクション 2.3) を参照してください。 

4.1.1.3 最終変更 
アプリケーションが作成されたら (使用する方法に関係なく)、Makefileファイルを開き、次の変更を加
えてください。 

https://www.cypress.com/ModusToolboxUserGuide
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• 新しい行を作成して、COREを CM0+に設定してください。デフォルトでは、makeファイルはアプリ
ケーションターゲットが CM4であると想定します。この行を追加すると、アプリケーションターゲ
ットは強制的に CM0+になります。 
CORE=CM0P 

• 必要に応じて、APPNAME変数を cy_m0p_imageに変更してください。これは、リンカースクリプト
で使用されるデフォルトの名前です。 
APPNAME=cy_m0p_image 

CM0+ CPUのコードを作成する場合、サイプレス HALを使用できないため、PDL APIのみを使用してく
ださい。 main.cファイルを変更して、HALへの参照をすべて削除してください。必要に応じて、BSPへ
の参照もすべて削除してください。 

例: 

#include "cy_pdl.h" 

#include "cyhal.h" 

#include "cybsp.h" 

 

int main(void) 

{ 

    cy_rslt_t result; 

 

    /* Initialize the device and board peripherals */ 

    result = cybsp_init() ; 

    if (result != CY_RSLT_SUCCESS) 

    { 

        CY_ASSERT(0); 

    } 

 

    enable_irq(); 

 

    Cy_SysEnableCM4(CY_CORTEX_M4_APPL_ADDR); 

 

    for (;;) 

    { 

        Cy_SysPm_DeepSleep(CY_SYSPM_WAIT_FOR_INTERRUPT); 

    } 

} 

サイプレス HALは CM0+で実行するように設計されていないため、正しくコンパイルされません。ま
た、1つの CPUのみ、優先的には CM4 CPUで BSPを初期化することを推奨します。 
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また CM0+アプリケーションは、デフォルトで design.modusで生成されたファイルを参照しません。こ
れらのファイルを CM0+アプリケーションの一部として含める場合は、CM0+ Makefileの COMPONENTS変
数に次を追加してください。 

COMPONENTS=BSP_DESIGN_MODUS 

または、カスタム design.modusを使用している場合は以下です。 

COMPONENTS=CUSTOM_DESIGN_MODUS 

4.1.2 CM4 CPUアプリケーションの作成 

4.1.2.1 ModusToolbox 用の Eclipse IDE の場合 
CM0+ CPU用に選択したものと同じ BSPに基づいて新しいアプリケーションを作成してください。任意
のアプリケーションテンプレートを選択できます。アプリケーションに「cm4_app」という名前を付け
て、アプリケーションの作成を完了してください。 

4.1.2.2 CLIの場合 
「cm4_app」アプリケーションを作成するために、project-creator-cliを再度実行してください。以下は
例です。 

 project-creator-cli \ 

  --board-id CY8CPROTO-062-4343W \ 

  --app-id mtb-example-psoc6-hello-world \ 

  --user-app-name cm4_app \ 

  --target-dir “C:/workspace_directory” 

-app-idで任意のテンプレートアプリケーションを使用できることに注意してください。完全なリストを
表示するには、Cypress GitHubリポジトリにアクセスしてください。 

4.1.2.3 最終変更 
アプリケーションが作成されたら、Makefileファイルを開き、次の変更を加えてください。 

• DISABLE_COMPONENTリストに「CM0P_SLEEP」を追加してください。別のビルド済みライブラリを使
用している場合は、それに応じてこれを変更してください。 
DISABLE_COMPONENTS=CM0P_SLEEP 

• 新しい行を作成して、cm0p_appへの相対パスを依存関係として追加してください。 
DEPENDENT_APP_PATHS=../cm0p_app 

手順を実行した後、Figure 4に示すように、Project Explorerウィンドウ (ModusToolboxの Eclipse IDEの
み) でアプリケーションを表示できます。どちらのアプリケーションにも、独自のライブラリ、構成、
および makeファイルのセットがあります。 

https://github.com/cypresssemiconductorco?q=mtb-example-psoc6&type=&language=
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Figure 4 Project Explorer 

CM4アプリケーションは、依存する CM0+アプリケーションを自動的に構築します。アプリケーション
を 2回リンクします。1回は CM0+イメージなしで、もう 1回は CM0+イメージありです。デフォルトの
イメージには、ビルド済みのイメージの 1つを使用して CM4アプリケーションをビルドする場合と同じ
ように、CM0+イメージが含まれます。 

ModusToolbox用の Eclipse IDEでは、アプリケーションをビルドまたはプログラミングするときに、ア
プリケーションを選択する必要があります。Project Explorerで、アプリケーションに属する任意のファ
イルまたはフォルダをクリックできます。Quick Panelは、選択したアプリケーションに基づく起動スク
リプトを含むリンクを更新します。 

CPUの 1つでのみハードウェアを初期化することを推奨します。したがって、design.modusファイルの
1つだけを編集する必要があります。 

mtb_sharedフォルダには、両方のアプリケーションで共有される可能性のあるライブラリと BSPファ
イルが含まれます。各アプリケーションには、独自の depsフォルダがあります。アプリケーションが
使用する可能性のある依存関係ライブラリをこのフォルダに追加します。同じライブラリが両方のアプ
リケーションで表示される場合があることに注意してください。 

4.1.3 リンカースクリプトのカスタマイズ 
CM0+および CM4アプリケーションには、それぞれ独自のリンカースクリプトがあります。デフォルト
では、CM0+ CPUは 8192 [0x2000]バイトのフラッシュと 8192 [0x2000]バイトの SRAMのみを消費します。
CM0+アプリケーションがより多くのメモリを必要とする場合は、両方のリンカースクリプトを変更する
必要があります。次の手順に変更点を示します。 

1. プロジェクトのルートディレクトリにカスタムリンカースクリプトを保存するための共有フォルダ
を作成してください。以下は例です。 
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shared / linker_script / COMPONENT_CM0P 
shared / linker_script / COMPONENT_CM4 

2. CM0+リンカースクリプト ファイルを以下のフォルダから「shared / linker_script / COMPONENT_CM0P」
フォルダにコピーしてください。 
mtb_shared / TARGET_<BSP_NAME> / COMPONENT_CM0P / TOOLCHAIN_<TOOL_NAME> / 

デフォルトでは、BSPは ARM (*.sct)、GCC_ARM (*.ld)、および IAR (*.icf) ツールチェーンをサポートしま
す。 各ツールチェーンには、独自のリンカースクリプトがあります。 

3. 必要に応じて FLASHと SRAMのサイズを編集してください。 

ツールチェーン 変更する場所 
ARM (*.sct) #define RAM_SIZE                0x00002000 

#define FLASH_SIZE              0x00002000 

GCC_ARM (*.ld) ram         (rwx)   : ORIGIN = 0x08000000, LENGTH = 0x2000 

flash       (rx)    : ORIGIN = 0x10000000, LENGTH = 0x2000 

IAR (*.icf) define symbol __ICFEDIT_region_IRAM1_end__   = 0x08001FFF; 

define symbol __ICFEDIT_region_IROM1_end__   = 0x10001FFF; 
 

4. CM4リンカースクリプト ファイルを以下のフォルダから「shared / linker_script / COMPONENT_CM4」
フォルダにコピーしてください。 
mtb_shared / TARGET_<BSP_NAME> / COMPONENT_CM4 / TOOLCHAIN_<TOOL_NAME> / 

5. CM0+メモリサイズに基づいて値を編集してください。 

ツールチェーン 変更する場所 
ARM (*.sct) #define RAM_START               0x08002000 

#define RAM_SIZE                0x000FD800 

#define FLASH_CM0P_SIZE         0x2000 

GCC_ARM (*.ld) FLASH_CM0P_SIZE = 0x2000; 

ram          (rwx) : ORIGIN = 0x08002000, LENGTH = 0xFD800 

IAR (*.icf) define symbol __ICFEDIT_region_IRAM1_start__ = 0x08002000; 

define symbol __ICFEDIT_region_IRAM1_end__   = 0x080FF7FF; 

6. CM0+アプリケーションの makeファイルで APPNAMEに「cy_m0p_image」とは異なる名前を付けた
場合、リンカースクリプト内のすべての参照を新しい名前に置き換える必要があります。 

7. CM0+および CM4 Makefileで、カスタムリンカースクリプトを参照するために、以下の行を追加して
ください。 
LINKER_SCRIPT=../shared/linker_script/COMPONENT_$(CORE)/<FILENAME>.<EXTENSION> 

手順 (1) と (2) で作成したリンカースクリプト フォルダにコピーしたファイルに基づいて、FILENAMEと
EXTENSIONを置き換える必要があります。 

8. CM0+ Makefileで、CM4アプリケーションアドレス (CY_CORTEX_M4_APPL_ADDR) を DEFINESに追加
してください。例えば、CM0+イメージのサイズが 0x8000の場合は、次のように設定してください。 
DEFINES=CY_CORTEX_M4_APPL_ADDR=0x10008000 

4.1.4 ライブラリと周辺機器の共有 
前に説明したように、CM4と CM0+は、アプリケーションで使用されるライブラリの一部を共有するこ
とも、共有しないこともできます。各アプリケーションの depsフォルダには、アプリケーションで使
用されるライブラリのリストが含まれます。ModusToolboxは、Library Managerと呼ばれるライブラリ
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と BSPを管理するためのツールを提供します。このツールは、ModusToolboxの Eclipse IDE、Quick 
Panel > Tools > Library Managerから起動できます。または、このフォルダ 
(<install_path>ModusToolbox/tools_<version>/library-manager/) にある Library-managerツールも実行で
きます。 

Figure 5に示すように、BSPまたはライブラリを選択すると、ツールはそれを共有するオプション 
(Shared列) を提供します。 
 

 
Figure 5 Library Manager 

デュアル CPUアプリケーションでは、すべてのライブラリと BSPを共有することを推奨します。 

周辺機器の構成に関しては、デュアル CPUアプリケーションで design.modusを 1つだけにし、
init_cycfg_all()または cybsp_init()、優先的には CM4を呼び出す CPUを 1つだけにすることを推
奨します。周辺機器が CPUの 1つだけで使用される場合は、単一の CPUアプリケーションで使用する
のと同じように使用できます。 

周辺機器が共有される場合は、いずれかの CPUでのみ初期化し、何らかの mutexまたは同期メカニズ
ムを使用して、両方の CPUが同時に使用しないようにする必要があります。CM0+は CM4によって作成
された HALオブジェクトにアクセスできないため、共有ペリフェラルに HALを使用することは推奨しま
せん。 

4.2 PSoC Creatorの説明 
PSoC 6 MCUデュアル CPUデバイス用の PSoC Creatorプロジェクト開発は、PSoC Creatorでサポートさ
れる他のデバイス用のそれと似ています。新しいプロジェクトを作成するには、File > New > Projectを
選択します。Figure 6のような Create Projectダイアログが表示されます。 
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Figure 6 PSoC Creatorの Create Projectダイアログ 

Target Device (A)、PSoC 6 (B) を選択してください。プルダウン リスト (C) で、<Launch Device 
Selector ...>を選択し、PSoC 6デバイスのリストを表示してください。 

Figure 7に、Device Selectorダイアログを示します。デュアル CPUデバイスのリストを表示するために
は、CPUカテゴリ (D) をクリックし、CortexM0p, CortexM4を選択してください。 

PSoC 6 Bluetooth LE Pioneer Kit CY8CKIT-062-BLEでは、PSoC 6 MCUデュアル CPUデバイスの製品番号は
CY8C6347BZI-BLD53です。PSoC 6 WiFi-BTパイオニアキット CY8CKIT-062-WiFi-BTでは、PSoC 6 MCUデ
ュアル CPUデバイスの部品番号は CY8C6247BZI-D54です。 
 

D

 

Figure 7 PSoC Creatorの Device Selectorダイアログ 

PSoC 6 MCU製品を選択した後、プロジェクト作成プロセスの残りの部分は他のデバイスと同じです。残
りの Create Project ダイアログをクリックしてください。PSoC Creatorがプロジェクトを作成します。 

初期プロジェクト ウィンドウ レイアウト (Figure 8) は、デュアル CPUデバイス用の以下の機能を備えた
Workspace Explorerウィンドウが含まれます。 

http://www.cypress.com/psoc-6-ble-pioneer-kit
http://www.cypress.com/documentation/development-kitsboards/psoc-6-wifi-bt-pioneer-kit
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• 各 CPUに個別の main.cファイル (main_cm0p.cと main_cm4.c)。フォルダ CM0p (Core 0) と CM4 (Core 
1) のソースコード ファイルは、それぞれの CPUの別々のバイナリにコンパイルされます。 

• Shared Filesフォルダ。このフォルダ内のソースコード ファイルは、両方のバイナリにコンパイルさ
れます。 

 

1

2

1

 

Figure 8 デュアル CPUデバイスの PSoC Creator初期プロジェクト レイアウト 

初期プロジェクト レイアウトには、TopDesignハードウェア回路図と関連するコンポーネント カタログ 
ウィンドウも含まれます。 

プロジェクトを作成した後、コンポーネントを回路図にドラッグして設定し、配線して、ハードウェア
設計を実装してください。 

回路図デザインが完了すると、Build > Generate Applicationを選択します。これにより、Figure 9に示
すように、既存フォルダだけでなく、新しいフォルダ Generated Sourceにいくつかのシステム ソース 
コード ファイルとフォルダが作成されます。 

生成されたソースには、回路図上の各コンポーネントのドライバとサイプレス ペリフェラル ドライバ 
ライブラリ (PDL) が含まれます。PDLは、デバイス ヘッダ ファイル、スタートアップ コード、ペリフェ
ラルドライバを統合するソフトウェア開発キット (SDK) です。ペリフェラル ドライバは、ハードウェア
機能を使いやすい一連の APIに抽象化します。 

PDLの詳細情報は Help > Documentation > Peripheral Driver Libraryを選択します。また、各コンポーネ
ントはそのドライバ APIを記述したデータシートがあります。コンポーネントを右クリックし、Open 
Datasheet ...を選択します。 

PSoC Creatorは、いくつかの他のファイルとフォルダを作成し、既存のフォルダ CM0p (Core 0), CM4 
(Core 1) および Shared Filesに配置します。これらのファイルは、一般に PSoC Creatorのほか、他の IDE
に設定、スタートアップおよびリンクのオプションを提供します。これらのファイルの詳細は、PSoC 
Creatorのヘルプ記事 Generated Files (PSoC 6) を参照してください。 
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Figure 9 生成されたソースをプロジェクトに追加 

4.3 リソース割当ての検討事項 
すべての PDLドライバソースと他の APIファイルは両方の CPUで利用可能です。CPUのコードが生成さ
れたソースファイルの API要素を参照する場合、そのファイルはその CPUのバイナリにコンパイルされ
ます。同じファイルを両方のバイナリにコンパイルできます。詳細はサンプルコードの CE216795 - 
PSoC 6 MCU Dual-CPU Basicsを参照してください。 

同じソースファイルが両方のバイナリにコンパイルする場合、そのファイル内の関数が両方のバイナリ
に複製されます。 コピーが別々のビルドとバイナリに入っても、場合によっては、両方の CPUによっ
て同時に実行される関数を検討すると便利です。 

前述のように、ペリフェラルが両方の CPUからアクセスされる可能性があります。例えば、両方の CPU
が同じ UARTを介してデータを送信することがあります。一般に、PDLドライバ関数は「CPU-safe」で
あり、つまり、これらの機能は両方の CPUで同時に実行できます。ただし、各 CPUにリソースを割当
てることについて設計上の決定をする必要があります。これを行うには以下の 2つの方法があります。 

• リソースを 1つの CPU専用にします。目的の CPUのファームウェアでのみリソースを使用するため
のコードを含めます。 また、PSoC Creatorを使用する場合、Figure 10に示すように、リソースを
「所有する」CPUをプロジェクトの回路図で指定することを推奨します。 

http://www.cypress.com/ce216795
http://www.cypress.com/ce216795
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Figure 10 個別ピン コンポーネントを制御するデュアル CPUの PSoC Creatorプロジェクト回路図 

• CPU間でリソースを共有します。サンプルコード CE216795は、CPU間でメモリ共有するために、
PSoC 6 MCUの IPCブロックを使用し、相互排除を実装する方法を示します。同じテクニックを使用
して、UARTなどのペリフェラル リソースを共有します。 

CPUのバイナリに割り当てられているフラッシュと SRAMは、通常、他の CPUのものとは別のもので
す。カスタム セクションとセクション配置が CPUのリンカ スクリプトで定義される場合、セクション
が重複しないようにする必要があります。メモリを共有する別の方法は、各 CPUに同じアドレスを持つ
カスタム セクションを定義することです。 

Note: 両方の CPUが同じ GPIOポートのピンを制御する場合は、ピン出力を変更するために次の
API関数のみを使用してください。GPIO_Write()、GPIO_Set()、GPIO_Clr()、および
GPIO_Inv()。詳細については、PDLのドキュメントの GPIO APIリファレンスを参照して
ください。 

4.4 割込み割当ての検討事項 
デュアル CPU設計の重要な検討事項は、割込みの割当てとその処理です。前述に示したように、すべて
のデバイス割込みは CM4で利用可能であり、割込みサブセットはマルチプレクサを経由し、CM0+にル
ーティングされます。設計では、どの CPUが各割込みを処理するかを決める必要があります。 

詳細については、アプリケーションノート AN217666、PSoC 6 MCU Interrupts を参照してください。 

ModusToolboxソフトウェア： ModusToolboxソフトウェアでは、割込みはプログラムで割り当てられ
ます。現時点では、GUIは対応しません。必要なコードの例は AN217666にあります。また、PDLのドキ
ュメントの「Cypress Bluetooth LEミドルウェアライブラリ」セクションの「Configure BLESS Interrupt」
サブセクションにあります。このサブセクションのコードは、PSoC 6 MCU BLEサブシステム (BLESS) 割
込みを CM0+または CM4に割り当てる方法を示します。コードは他の割込みソースに対応するように簡
単に修正できます。サイプレス HALは CM4でのみサポートされるため、HALドライバに必要なすべて
の割込みは CM4に割り当てられます。 

PSoC Creator： PSoC Creatorでは、サンプルデザインで割込みを割り当てます。Figure 11は、2つの割
込みを伴う設計を示します。1つは割込みコンポーネント MyPWM_Intに接続された PWMコンポーネン
トからのもの。もう 1つは I2Cコンポーネントからのものです。 

Design Wide Resourcesウィンドウ (ファイルタイプ .cydwr) で、Interruptsタブを選択して、デザイン内
のすべての割込みを確認します(Figure 12を参照)。 

この例では、I2Cコンポーネントに割込みが埋め込まれます。その割込みは Figure 11の回路図には示さ
れません。デザイン全体のリソースウィンドウに MyI2C_SCB_IRQとして表示されます。 

http://www.cypress.com/ce216795
http://www.cypress.com/an217666
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Figure 11 2つの割込みを持つ回路設計の例 

ARM CM0+ Enableおよび ARM CM4 Enableの列のチェック ボックスをオンまたはオフにして、それぞれ
の CPUに割込みを割当てます。 
 

 

Figure 12 CPUへの割込み割当て 

各ペリフェラル割込みは、CM4に配線接続されるため、プロジェクトをビルドする時に、Interrupt 
Numberが PSoC Creatorによって自動で割り当てられます。割込みはマルチプレクサ経由で CM0+にル
ーティングされるため、割込みごとに ARM CM0+ Vectorを選択できます。 

Note: 両方の CPUに 1つの割込みが割り当てられる場合、警告シンボルとツールチップが表示
されます。これは一般的に推奨しませんが、スリープ モードから一方または両方の CPU
を復帰させるために 1つの割込みを使用できます。 

4.5 デバッグに関する考慮事項 
Keil μVisionや IAR Embedded Workbenchなどのサードパーティ IDEは、デュアル CPUデバッグに対応し
ます。ModusToolboxおよび PSoC Creator用の IDEは、一度に 1つの CPU (CM4または CM0+のいずれか) 
のデバッグに対応します。 

4.5.1 ModusToolbox の手順 
ModusToolboxソフトウェア用の Eclipse IDEは、一度に 1つの CPU (CM4または CM0+のいずれか) のデバ
ッグに対応します。詳細な手順については、ModusToolbox User Guideを開き、サブセクション PSoC 6 
MCU Programming/Debuggingを参照してください。 

https://www.cypress.com/ModusToolboxUserGuide
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4.5.2 PSoC Creator の手順 
PSoC Creatorは一度に 1つの CPUのみのデバッグに対応します。PSoC 6 MCUでデバッグセッションを開
始する前に、Figure 13に示すように、希望するデバッグターゲットを選択してください (Debug >  
Select Debug Target...)。希望の CPUを選択し、OK / Connect をクリックしてください。他の CPUをデバ
ッグするには、デバッガを終了してから、その CPUに接続して再入力する必要があります。 
 

 

Figure 13 PSoC Creatorのデバッグ用 CPU選択 

推奨: 最初に、CPUが互いに通信するコード部分を開発してデバッグします。その後、個々の CPUで実
行されたコードを個別にデバッグできます。たとえば、CE216795の共有メモリプロジェクトが開発さ
れたとき、CM0+が CM4に初期メッセージを送信する部分が開発され、その後のコード部分が開発され
る前にデバッグされます。 

μVisionや IARなどの他の IDEを使用して、両方の CPUを同時にデバッグできます。そうするには、
PSoC Creatorプロジェクトを他の IDEにエクスポートする必要があります。PSoC Creatorは、このトピ
ックをヘルプ記事 Integrating into 3rd Party IDEs, PSoC 6 Designsに記載しています。ヘルプ記事の説明を
確認してください。一般的な手順は次のセクションにまとめられています。 

4.5.3 他の IDEの手順 

4.5.3.1 ModusToolboxソフトウェアからのエクスポート 
ModusToolboxソフトウェアには、makeファイルを介した次の IDEのエクスポートメカニズムがありま
す。 

1. IAR Embedded Workbench: make ewarm8 
2. Keil μVision: make uvision5 
3. Visual Studio Code: make vscode 

これらのツールを使用してデバッグをエクスポートおよび設定する方法の詳細については、
ModusToolbox User Guideの「IDEへのエクスポート」の章を参照してください。 

http://www.cypress.com/ce216795
https://www.cypress.com/ModusToolboxUserGuide
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これらの IDEはすべて、デュアル CPUデバッグに対応します。ただし、ModusToolboxを介してエクス
ポートされたプロジェクトで機能するのは Keil μVisionデュアル CPUデバッグのみです。 

ModusToolboxユーザーガイドの説明は、CM4をプログラム/デバッグするように設計されます。同じ手
順が CM0+にも適用されますが、いくつかの変更があります。使用している IDEに応じて、次の追加手
順を実行します。 

1. CM0 +を使用した VisualStudio Code 

CM0+プロジェクトに対して make vscodeコマンドを実行した後、”.Vscode”という新しいフォルダが作
成されます。このフォルダで、launch.jsonファイルを開き、次の変更を加えます。 

a) CM4のすべてのインスタンス名を CM0+に変更 
b) すべての targetProcessorインスタンスを (1ではなく) 0に設定 
2. CM0+を使用した Keil μVision 

CM4のプロジェクトを作成するときと同じ手順に従います。デュアル CPUデバッグを実行するには、
Keil μVisionの 2つのインスタンスを開きます。1つは CM0+プロジェクトで、もう 1つは CM4プロジェ
クトで開きます。どちらの場合も、Debug > Start/Stop Debug Sessionに移動します。 

3. IAR Embedded Workbench 

ModusToolboxの IARエクスポートメカニズムは、CM0+プロジェクトに対応しません。CM4プロジェク
トのみをエクスポートできます。 

4.5.3.2 PSoC Creator からのエクスポート 
PSoC Creatorを使用する場合は、プロジェクトを Keil μVisionまたは IAR Embedded Workbenchにエクス
ポートして、デュアル CPUデバッグを行えます。そのための手順は次のとおりです。 

1. PSoC Creatorプロジェクトの設定 

2. μVisionプロジェクトの生成 

3. µVisionプロジェクトのデバッグ 

4. IAR-EWプロジェクトの生成 

5. IAR-EWプロジェクトのデバッグ 

 

1. PSoC Creatorプロジェクトの設定 

Figure 14に示すように、プロジェクトの Build Settingsで Target IDEs設定を更新します。 

μVisionの場合は、CMSIS Pack: > Generateを選択します。Vendor、Pack、および Versionの各フィール
ドに、CMSISパックの適切な識別テキストを入力します。 

推奨: Toolchain: > ARM MDK Generic を選択してください。 

IARの場合は、IAR EW-ARM: > Generate を選択するだけです。 (高度なオプションである Generate 
without copying PDL files も利用できます。) IARには独自のコンパイラがあるため (PSoC Creatorでは対
応しません)、Toolchainの選択は関係ありません。 
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Figure 14 ターゲット IDEのビルド設定 

その後 PSoC Creatorプロジェクトを通常の方法でビルドします。フォルダ Exportが<project>.cydsnフォ
ルダに作成されます。このフォルダは、選択した 1つまたは複数の IDEにエクスポートするための関連
ファイルを含みます。 

μVisionの場合、PSoC Creatorプロジェクトがビルドされた後に、Export \ Packフォルダで対応する.pack
ファイルを見つけてください。Figure 15に示すように、ファイルをダブルクリックして μVisionパック
としてインストールしてください。 

Note: このパックのインストールのために µVision Pack Installer Wizard File Import機能を使用しな
いでください。 

 

 

Figure 15 PSoC Creatorプロジェクトから μVisionパックのインストール 

Note: PSoC Creatorプロジェクトを更新する場合は、µVisionパックのバージョン番号を変更し 
(Figure 14を参照)、新しいパックをインストールすることを検討してください。 

詳細については、AN219434 - PSoC 6 MCU Importing Generated Code into an IDE を参照してください。 

http://www.cypress.com/an219434
http://www.cypress.com/an219434


  

 

Application Note 25 of 49 002-23479 Rev. *B  
  2021-05-17
  

PSoC 6 MCU デュアル CPUシステム設計 
  
PSoC 6 MCUデュアル CPUでの開発プロセス 

  

2. μVisionプロジェクトの生成 

μVisionの場合、2つのプロジェクトを作成する必要があります。各 PSoC 6 MCU CPU (CM0+と CM4) に 1
つずつ。 以下を実施してください。 

推奨: PSoC Creatorの<project>.cydsnフォルダ内に新しいフォルダ (uVisionBuildなど)を作成して、すべ
ての μVisionプロジェクトファイルを PSoC Creatorファイルとは別に保存します (これは IARの手順とは
異なります)。 そのフォルダ内に、Figure 16に示すように、CM4オブジェクトファイル (ObjectsM4など) 
用の別の新しいフォルダを作成してください。 
 

 

Figure 16 µVisionプロジェクトの新しいフォルダ 

μVision 5.25以降を開き、uVisionBuildフォルダに新しいプロジェクトを作成します (Project > New 
µVision Project...) 。 

推奨: 元の PSoC Creatorプロジェクト名とターゲット CPUに基づいてプロジェクトに名前を付けます。
例えば、CE216795デュアル CPU点滅プロジェクトの場合、Figure 17のように、CM0+ CPU用の μVision
プロジェクト BlinkyM0pを作成します。 
 

 

Figure 17 CM0+用 µVisionプロジェクトの生成 

Saveをクリックすると、Select Device for Target ‘Target 1’...ダイアログボックスが表示されます。以前
にインストールされたパック (Figure 15) で定義された 2つの PSoC 6 MCU CPUが表示されます。 Figure 
18に示すように、CM0+ CPUを選択してください。 OKをクリックしてください。 

http://www.cypress.com/ce216795
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Figure 18 プロジェクトデバイスとして CM0+を選択 

次に、Manage Run-Time Environmentダイアログボックスが表示されます。Select Packsをクリック
し、Use latest versions of all installed Software Packsのチェックを外します。Figure 19に示すように、
PSoC Creatorプロジェクトからパックを選択します。 
 

 

Figure 19 PSoC Creatorプロジェクトパックの選択 



  

 

Application Note 27 of 49 002-23479 Rev. *B  
  2021-05-17
  

PSoC 6 MCU デュアル CPUシステム設計 
  
PSoC 6 MCUデュアル CPUでの開発プロセス 

  

OKをクリックしてください。Figure 20に示すように、Manage Run-Time Environmentダイアログが変わ
ります。 Device Startupと PDL Driversを選択し、OKをクリックしてください。Figure 21に示すよう
に、Target 1、Source Group 1、および Device startupと PDLファイルでプロジェクトが作成されます。 
 

 

Figure 20 パック開始と PDLドライバーファイルの選択 

 

 

Figure 21 初期プロジェクト生成 

Source Group 1を右クリックし、Add Existing Files to Group ‘Source Group 1’....を選択してください。
自身の PSoC Creatorプロジェクトフォルダに移動し、Figure 22に示すように main_cm0p.c, 
cy_ipc_config.c, および他のシステム以外のすべての.cとプロジェクトに必要なアセンブラファイルを選
択してください。.hファイル, スタートアップファイル, または system .cファイル, またはアセンブラフ
ァイルを追加する必要はありません。Addをクリックしてください。ファイルは μVisionプロジェクト
のソースグループに追加されます。 Closeをクリックしてください。 
 

 

Figure 22 PSoC Creatorプロジェクト Cソースファイルのソースグループへの追加 



  

 

Application Note 28 of 49 002-23479 Rev. *B  
  2021-05-17
  

PSoC 6 MCU デュアル CPUシステム設計 
  
PSoC 6 MCUデュアル CPUでの開発プロセス 

  

プロジェクトが作成されたので、次にそのオプションを設定する必要があります。Target 1を右クリッ
クし、Options for Target ‘Target 1’...を選択してください。Figure 23に示すように、Targetタブで、デ
バイス, CPU, IROM1, および IRAM1が PSoC 6 MCUデバイスに対して正しいことを確認してください。Xtal 
(MHz) やオペレーティングシステムなどの他のフィールドの更新はオプションです。 
 

 

Figure 23 プロジェクトターゲットオプション 

Userタブで、パックからビルド後の正しいバッチファイルが呼び出されていることを確認してくださ
い。Figure 24に示すように、User Commandフィールドの上にカーソルを置き、
postbuildCortexm0p.batが呼び出されることを確認してください。 必要に応じて、他のビルド前および
ビルド後のバッチファイルを追加し、他のオプションを選択してください。 
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Figure 24 プロジェクトユーザーオプション 

Figure 25に示すように、C/C++タブで C99 modeオプションがチェックされていることを確認してくだ
さい。(PDLは C99に基づいて開発されています。) PSoC Creator <project>.cydsnフォルダを Include 
Pathsに追加します。これは PSoC Creatorプロジェクト内の.hファイルへのリンクを提供します。必要
に応じて他のオプションとフィールドを更新してください。 
 

 

Figure 25 プロジェクト C/C++オプション 
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Figure 26に示すように、Linkerタブで、R/O Baseと R/W Baseフィールドが PSoC 6 MCUデバイスに対
して正しいことを確認してください。PSoC Creatorプロジェクトフォルダから適切な Scatter Fileを選択
してください。 
 

 

Figure 26 プロジェクトリンカーオプション 

CY8CKIT-062-BLEの USBポートをコンピュータに接続してください。キットボタン SW3を押して
KitProg2を CMSIS-DAPモードにします。詳細はキットガイドを参照してください。これにより、外部プ
ローブを使用せずにデバッグできます。 

Figure 27に示すように、Debugタブで、Use CMSIS-DAP Debuggerを選択してください。Settingsをク
リックし、KitProg2 CMSIS-DAPを選択して、他のすべての設定が表示されているデフォルトになってい
ることを確認してください。OKをクリックしてオプションダイアログに戻ってください。 
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Figure 27 プロジェクトデバッグオプション 

Utilitiesタブで、Use Debug Driverがチェックされていることを確認し、Update Target before 
Debuggingのチェックを外してください。Figure 28に示すように、Settingsをクリックし、Download 
Functionボックスのチェックをすべて外してください。Do not Eraseをクリックしてください。OKを
クリックして Optionsダイアログに戻ってください。 警告 “Nothing to do ... ” が表示されます。OKをク
リックしてください。 アプリケーションは CM4プロジェクトによってロードされます。OKをクリック
してオプション設定を保存して閉じてください。 
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Figure 28 プロジェクトユーティリティオプション 

前のステップを繰り返して、CM4用の 2番目のプロジェクトを作成してください。 

推奨: オリジナルの PSoC Creatorプロジェクト名とターゲット CPUに基づいてプロジェクトに名前を付
けてください。例えば、CE216795デュアル CPU点滅プロジェクトの場合は、μVisionプロジェクト
BlinkyM4pを作成してください。Figure 17を参照してください。以下の違いを除いて、CM0+プロジェク
トと同じ方法でプロジェクトを構成してください。 

• CM4プロジェクトは CM0+プロジェクトと同じフォルダになければなりません。この場合は
uVisionBuildです。 Figure 17を参照してください。 

• 以前にインストールしたパックから CM4 CPUを選択してください。Figure 18を参照してください。 
• Figure 22に示すように、PSoC Creatorプロジェクトフォルダに移動し、main_cm4.c、

cy_ipc_config.c、およびプロジェクトに必要な他のすべてのシステム以外の.cファイルとアセンブラ
ファイルを選択してください。.hファイル, スタートアップファイル, system .cファイル, またはアセ
ンブラファイルを追加する必要はありません。 

• Optionsダイアログの Outputタブで、Select Folder for Objects...をクリックして、作成した
ObjectsM4フォルダを選択してください。Figure 16を参照してください。 

• Optionsダイアログの C/C++タブで、Misc Controlsに--fpu=fpv4-spを追加してください。Figure 
25を参照してください。 

http://www.cypress.com/ce216795
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• Figure 29に示すように、Optionsダイアログの Linkerタブで、"cm4_dual" スキャッタファイルを選
択してください。CM4プロジェクトは両方の CPUのコードを含みます。Misc Controlsに--
fpu=fpv4-spを追加してください。 

 

 

Figure 29 CM4プロジェクト用リンカーオプション 

• Optionsダイアログの Debugタブの Target Driver Setupで、Resetオプションに VECTRESETを選択し
てください。Figure 27を参照してください。 

• Figure 30に示すように、Optionsダイアログの Utilitiesタブで、Update Target before Debuggingが
チェックされていることを確認してください。示されるようにアルゴリズム値の RAMを設定してく
ださい。Reset and Runの確認はオプションですが便利です。 
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Figure 30 CM4プロジェクト用ユーティリティオプション 

最後に、uVisionBuildフォルダに、例えば Blinkyという名前の μVisionワークスペース (Project > New 
Multi-Project Workspace...) を作成してください。作成した 2つのプロジェクトをそのワークスペースに
追加してください。作成したワークスペースとプロジェクト, および対応するファイルは、Figure 31の
ようになります。 
 

 

Figure 31 結果の μVisionプロジェクトウィンドウとプロジェクトファイル 

プロジェクトを順番にビルドしてください。最初に CM0+プロジェクトをビルドしてください。μVision
には、プロセスを自動化するためのバッチビルド機能があります。ビルドが正常に完了したら、
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BlinkyM4プロジェクトを右クリックして、それをアクティブプロジェクトとして設定してください。次
に、(1)フラッシュを消去 (Flash > Erase) し、(2)プロジェクトをダウンロード (Flash > Download) して正
しい動作を確認して、ビルドオプションをテストしてください。Reset and Runを選択しなかった場合 
(Figure 30参照)、操作を開始するにはキットのリセットボタン (RST / SW1) を押す必要があります。 

Note: CM0+プロジェクト内のコードを変更した場合は、両方のプロジェクトを再ビルドする必
要があります。μVisionには、プロセスを自動化するためのバッチビルド機能があること
に注意してください。 

3. µVisionプロジェクトのデバッグ 

CM4プロジェクトでデバッグを開始してください。CM4プロジェクトをダウンロードすると、両方の
CPUのコードがインストールされます。CM4プロジェクトをアクティブプロジェクトとして設定し、必
要に応じてそれをダウンロードし、Debug > Start/Stop Debug Sessionをクリックしてデバッグを開始し
てください。μVisionウィンドウは、Figure 32のようになります。 
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Figure 32 CM4デバッグウィンドウ 

CE216795デュアル CPU点滅プロジェクトを実行している場合は、63行目に Cy_Syslib_Delay()にブ
レークポイントを設定してください。次に Debug > Runの順にクリックすると、赤い LEDがブレークポ
イントで停止するたびに切り替わります。 

そして μVisionの 2番目のインスタンスを開き、同じワークスペースをロードしてください。両方のイ
ンスタンスがキット接続と PSoC 6 MCUデバッグアクセスポート (DAP) を共有します。CM0+プロジェク
トをアクティブにして、デバッグセッションを開始してください。63行目の Cy_Syslib_Delay()にブ
レークポイントを設定してください。次に Debug > Runの順にクリックすると、青い LEDがブレークポ
イントで停止するたびに切り替わります。 

http://www.cypress.com/ce216795
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Note: 55行目で Cy_SysEnableCM4()関数呼び出しを実行すると、CM4の実行が再開されます。
CM4ウィンドウに行き、Debug > Stopの順にクリックし、次に Debug > Runの順にクリッ
クしてください。CM4は再びブレークポイントまで実行されます。 

インスタンスウィンドウをデスクトップに並べて配置すると便利です。ウィンドウは、Figure 33のよう
に表示されます。適切なウィンドウをクリックして、目的の CPUでデバッグ操作を実行してください。
ブレークポイントは CPUごとに個別に設定できることに注意してください。どちらのウィンドウからも
同じメモリアドレスを読み出して更新できます。 
 

 

Figure 33 µVisionデュアル CPUデバッグ 

4. IAR-EWプロジェクトの生成 

IAR Embedded Workbench (IAR-EW) の場合、2つのプロジェクトを作成する必要があります。CM0+と CM4
の各 PSoC 6 MCU CPUに 1つずつです。以下を実施してください。 

Note: IAR-EWプロジェクトファイルは PSoC Creatorの<project>.cydsnフォルダに作成する必要が
あります。PSoC Creatorの<project>.cydsnフォルダ内に別のフォルダを作成しないでくだ
さい (これは µVisionの手順とは異なります) 。 

推奨: 同じフォルダ内の PSoC Creatorファイルと IAR-EWファイルを区別するために、各プロジェクトと
ワークスペースのファイル名に“IAR_”などのタグを追加してください。 

Arm 8.22以降用の IAR Embedded Workbenchを開き、新しいプロジェクトを作成してください (Project > 
Create New Project...) 。Create New Projectダイアログ (Figure 34) で、ツールチェーンが Armであるこ
とを確認し、Empty projectテンプレートを選択して OKをクリックしてください。 
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Figure 34 IAR Embedded Workbenchの新規プロジェクトの作成ダイアログ 

推奨: ダイアログ (Figure 35) の保存で、元の PSoC Creatorプロジェクト名とターゲット CPUに基づいて
プロジェクトに名前を付けてください。例えば、CE216795デュアル CPU点滅プロジェクトの場合は、
CM0+ CPU用の μVisionプロジェクト IAR_BlinkyM0pを作成してください。 
 

 

Figure 35 CM0+用 IAR Embedded Workbenchプロジェクトの生成 

Tools > Optionsを選択し、Enable project connectionsがチェックされていることを確認してください。
OKをクリックしてください。次に、Project > Add Project Connection...を選択してください。次のダイ
アログで、IAR Project Connectionを使用して接続を選択し、OKをクリックしてください。次に、
Figure 36に示すように...CortexM0p.ipcfファイルを選択してください。OKをクリックすると、いくつか
のフォルダとファイルが Workspaceウィンドウのプロジェクトに追加されます。 

http://www.cypress.com/ce216795
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Figure 36 PSoC Creatorプロジェクトエクスポートフォルダから IARプロジェクト接続ファイル

の選択 

プロジェクトが作成されたので、次にそのオプションを設定する必要があります。プロジェクトを右ク
リックして、Options...を選択してください。Figure 37に示すように、Optionsダイアログの Build 
Actionsセクションで postbuildCortexM0p.batが呼び出されることを確認してください。 
 

 

Figure 37 PSoC Creatorポストビルドバッチファイルの選択 
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Debuggerセクションの Setupタブで、CMSIS DAPドライバを選択してください。 Downloadタブで、
Suppress downloadをチェックしてください。CMSIS DAPセクションの Setupタブで、Resetを
Disabled (no reset) に設定してください。アプリケーションは CM4プロジェクトによってロードされま
す。Interfaceタブで、SWDを選択してください。OKをクリックしてください。 

前のステップを繰り返して、CM4用の 2番目のプロジェクトを作成してください。推奨: オリジナルの
PSoC Creatorプロジェクト名とターゲット CPUに基づいてプロジェクトに名前を付けてください。例え
ば、CE216795デュアル CPU点滅プロジェクトの場合は、IAR-EWプロジェクト IAR_BlinkyM4を作成して
ください。Figure 35を参照してください。プロジェクトを CM0+プロジェクトと同様に構成してくださ
い。以下の違いがあります。 

• CM4プロジェクトは CM0+プロジェクトと同じフォルダになければなりません。この場合、自身の
PSoC Creator <project>.cydsnフォルダです。Figure 35を参照してください。 

• ...CortexM4.ipcfファイルを選択してください。Figure 36を参照してください。 
• Figure 38に示すように、Optionsダイアログの General Optionsセクションの Outputタブで、オブ
ジェクトファイルとリストファイルの出力ディレクトリを変更してください。実行可能ファイル/ラ
イブラリの出力フォルダを変更しないでください。 

 

 

Figure 38 CM4プロジェクト用固有出力フォルダ 

• Build Actionsセクションで、postbuildCortexM4.batが呼び出されることを確認してください。Figure 
37を参照してください。 

• Debuggerセクションの Setupタブで、CMSIS DAPドライバを選択してください。CMSIS DAPセクシ
ョンの Setupタブで、Resetが System (default) に設定されていることを確認してください。
Interfaceタブで、SWDを選択してください。OKをクリックしてください。 

File > Save Allを選択してください。両方のプロジェクトのすべてのファイルが保存され、ワークスペー
スファイルが自動的に生成されます。Save Workspace Asダイアログで、PSoC Creatorの<project>.cydsn

http://www.cypress.com/ce216795
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フォルダに、例えば IAR_Blinkyという名前の IAR-EWワークスペースを作成してください。作成された
ワークスペースとプロジェクト、および対応するファイルは、Figure 39のようになります。IAR-EWに
よって生成されたファイルとフォルダが強調表示されます。 
 

 

Figure 39 IAR Embedded Workbenchプロジェクトウィンドウとプロジェクトファイルの結果 

CY8CKIT-062-BLEの USBポートをコンピュータに接続してください。キットボタン SW3を押して
KitProg2を CMSIS-DAPモードにしてください。詳細はキットガイドを参照してください。これにより、
外部のデバッグプローブを使用せずにデバッグできます。 

プロジェクトを順番にビルドしてください。最初に CM0+プロジェクトをビルドしてください。IAR-EW
には、プロセスを自動化するためのバッチビルド機能があることに注意してください。ビルドが正常に
完了したら、BlinkyM4プロジェクトを右クリックしてそれをアクティブプロジェクトとして設定してく
ださい。次に、(1)フラッシュを消去し (Project > Download > Erase memory) 、(2)プロジェクトをダウン
ロードし (Project > Download > Download active application) 、正しい操作を確認して、ビルドオプショ
ンが正しいことを確認してください。ダウンロード後、キットリセットボタン (RST / SW1) を押して動作
を開始してください。 

Note: フラッシュを消去する場合、通常は PSoC 6 MCUアプリケーションフラッシュ 
(0x1000 0000 – 0x100F FFFF) のみを消去する必要があります (Figure 40を参照) 。 

 

 

Figure 40 IAR PSoC 6 MCU用 Embedded Workbench消去メモリダイアログ 
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Note: CM0+プロジェクトのコードを変更する場合は、両方のプロジェクトを再ビルドする必要
があります。IAR-EWには、プロセスを自動化するためのバッチビルド機能があることに
注意してください。 

5. IAR-EWプロジェクトのデバッグ 

CM4プロジェクトのオプションを再度開き、Debuggerセクションの Multicoreフォルダに移動してくだ
さい。PSoC 6 MCUには異なるコア、つまり CM0+と CM4があり、これらは「非対称マルチコア」と呼ば
れます。したがって、Figure 41に示すように、Asymmetric multicoreセクションのフィールドに入力
してください。Enable multicore master modeにチェックを入れると、CM4 CPUはダウンロードおよび
デバッグ用のマスタになります。Portを変更しないでください。 
 

 

Figure 41 マルチコアデバッグの設定 

File > Save Allを選択してプロジェクトオプションの変更を保存してください。次に、Project > 
Download and Debugまたは Project > Debug without Downloadingを選択してデバッグを開始してくだ
さい。IAR Embedded Workbenchの 2番目(スレーブ) のインスタンスは、CM0+プロジェクト用に自動的
に開かれます。両方のインスタンスがキット接続と PSoC 6 MCUデバッグアクセスポート (DAP) を共有し
ます。 

スレーブインスタンスで、63行目に Cy_Syslib_Delay()にブレークポイントを設定してください。次
に、Debug > Goを繰り返しクリックすると、青い LEDがブレークポイントで停止するたびに切り替わり
ます。 

CM4インスタンスウィンドウ内の任意の場所をクリックして、手順を繰り返してください。赤い LEDは
ブレークポイントで停止ごとに切り替わります。 
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インスタンスウィンドウをデスクトップに並べて配置すると便利です。ウィンドウは、Figure 42のよう
に表示されます。適切なウィンドウをクリックして、目的の CPUでデバッグ操作を実行してください。
ブレークポイントは CPUごとに個別に設定できることに注意してください。どちらのウィンドウからも
同じメモリアドレスを読み出して更新できます。 
 

 

Figure 42 IAR Embedded Workbenchデュアル CPUデバッグ 

どちらのウィンドウでもデバッグを中止できます。両方の CPUのデバッグは終了します。キットのリセ
ットボタン (RST / SW1) を押してキットの操作を再開してください。 
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5 まとめ 
本アプリケーション ノートでは、PSoC 6 MCUのデュアル CPU機能のファームウェアおよびハードウェ
ア設計を使用および最適化する方法を示しました。 

PSoC 6 MCU設計を最適化するもう 1つの方法は、PSoCがプログラマブル アナログおよびデジタル ブロ
ックでカスタム機能を構築できる柔軟なデバイスとして設計されるということに基づきます。例えば、
PSoC 6 MCUには「コプロセッサ」として動作する以下のペリフェラルがあります。 

• DMAコントローラー。Cコンパイラによって出力される最も一般的な CPUアセンブラ命令は MOV, 
LDR, および STRであることに注意してください。これは、CPUがバイトを移動するだけで多くのサ
イクルを費やすことを意味します。かわりに DMAコントローラーがそれを実行させます。 

Note: PSoC 6 MCU DMAコントローラーは、CPUとは独立した複雑なデータ転送および制御シス
テムを構築するための様々な機能を持ちます。 これらの機能のソフトウェアサポート
は、ModusToolboxソフトウェア Device Configurator、PSoC Creator DMAコンポーネント, お
よび PDLの APIで提供されています。詳細については、Device Configuratorのヘルプガイ
ド, DMAコンポーネントのデータシート, または PDLのマニュアルを参照してください。
サイプレス HALは CM4 CPUのみをサポートするため、DMA HALドライバは CM4アプリケ
ーションでのみ機能します。 

• 暗号化ブロック。このブロックは、対称および非対称暗号方式 (AES、3DES、RSA、および ECC) のハ
ードウェア アクセラレーションおよびハッシュ関数 (SHA-512、SHA-256) を提供します。また、真の
乱数発生器 (TRNG) 機能も備えます。これらの機能のソフトウェア サポートは、PDLの APIによって
提供されます。詳細は PDL文書を参照してください。サイプレス HALには現在暗号ドライバがあり
ません。 

• 汎用デジタルブロック (UDB)。12個の UDBがあり、各 UDBには 8ビットのデータパスがあり、これ
を加算、減算、ビット単位演算、シフト、巡回冗長検査 (CRC) に使用できます。データパスは、ワー
ド幅計算のために連鎖させることができます。CPU計算をデータパスにオフロードすることを検討し
てください。現時点では、PSoC Creatorのみが UDBに対応します。ModusToolboxソフトウェアは
UDBに対応しません。 

• UDBは、ステートマシンの構築に使用できるプログラマブル ロジック デバイス (PLD) も備えます。
サンプルは、ルックアップ テーブル (LUT) コンポーネント データシートを参照してください。LUTは
C言語のスイッチ文／ケース文などを使用し、CPUのプログラミング ステート マシンの代わりに効
果的なハードウェアベースの代替デバイスにできます。 
さらに、2つの GPIOポートには、GPIOピンに入出力する信号を直接ブール演算するために使用でき
るスマート I/O™が含まれます。サイプレス HALはスマート I/Oに対応しません。 

• その他のスマート ペリフェラルには、シリアル通信ブロック (SCB)、カウンター／タイマー／PWMブ
ロック (TCPWM)、Bluetooth Low Energy (Bluetooth LE)、I2S／PDMオーディオ、プログラマブル アナロ
グ、CapSense®を含みます。これらのペリフェラルを使用して、CPUからの処理をさらにオフロード
します。 

PSoC Creatorは、ペリフェラルの機能をサポートするために、多くのコンポーネントと PDLの広範な
APIを提供します。これにより、効果的なマルチプロセッシング システムをシングル チップに開発し、
CPUから多くの処理をオフロードできます。これは、コード サイズを縮小するだけでなく、CPUが実行
しなければならないタスクの数を減らすことによって、CPU速度と消費電力を削減する機会を提供しま
す。 

例えば、CPUの使用なしで多重化 ADC入力を制御し、DMAとインターフェースして SRAMにデータを保
存し、高度なアナログ データ収集システムを作成するデジタル システムを実装します。 
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ModusToolboxソフトウェアは、周辺機器をセットアップするための一連のツール、すべてのサイプレ
スキット用の事前定義された BSP、CapSenseや emWinなどの一般的な機能用のライブラリ、および開
始するための包括的な一連のサンプルアプリケーションを提供します。 

サイプレスは、PSoCペリフェラルに関する広範なアプリケーション ノートとサンプル コードだけでな
く、デバイス データシート、PDL文書、HAL文書、およびテクニカル リファレンス マニュアル (TRM) の
詳細情報を提供しています。詳細は関連文書を参照してください。 

http://www.cypress.com/documentation/code-examples/psoc-6-mcu-code-examples
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6 関連資料 
PSoC 6 MCUリソースの包括的なリストについては、サイプレスコミュニティの KBA223067を参照して
ください。 

アプリケーションノート 
AN221774 – Getting Started with 
PSoC 6 MCU 

PSoC 6 MCUデバイスと、最初の ModusToolboxまたは PSoC 
Creatorプロジェクトを構築する方法について説明 

AN210781 – Getting Started with 
PSoC 6 MCU with Bluetooth Low 
Energy (BLE) Connectivity 

BLE Connectivityデバイスを搭載した PSoC 6 MCUと、はじめて
PSoC Creatorプロジェクトを構築する方法について説明 

AN217666 – PSoC 6 MCU 
Interrupts 

PSoC 6 MCUの割込みアーキテクチャと割込みの設定方法について
説明 

AN219434 – Importing PSoC 
Creator Code into an IDE for a 
PSoC 6 MCU Project 

PSoC Creatorで生成されたコードを好みの IDEにインポートする
方法について説明 

サンプル コード (PSoC Creator) 

CE216795 – PSoC 6 MCU Dual-Core 
Basics 

PSoC 6 MCUの 2つの CPUコアで独立したタスクを実行し、共有メ
モリとプロセッサ間通信 (IPC) ブロックを使用して相互通信する方
法について説明 

CE223820 – PSoC 6 MCU IPC Pipes 
この例は、プロセッサ間通信 (IPC) ドライバを使用して PSoC 6 
MCUにメッセージパイプを実装する方法を示します。パイプは、
CPU間でメッセージを送信するために使用されます。 

CE223549 – PSoC 6 MCU IPC 
Semaphore 

この例は、プロセス間通信 (IPC) ドライバを使用して PSoC 6 MCU
にセマフォを実装する方法を示します。セマフォは、CPUによっ
て共有されるリソースへのアクセスを制御するためのロックとし
て使用されます。 

CE226306 – PSoC 6 MCU Power 
Measurements 

この例は、PSoC 6 MCUデータシートにリストされている電力測定
を実現する方法を示します。 

サンプル コード (ModusToolbox) 
mtb-example-psoc6-dual-cpu-
empty-app 

これは、PSoC 6 MCUデバイス用の最小限のスターターデュアル
CPUアプリケーションテンプレートです。 

mtb-example-psoc6-dual-cpu-
ipc-sema 

この例は、プロセッサ間通信 (IPC) ドライバを使用して PSoC 6 
MCUにセマフォを実装する方法を示します。セマフォは、CPUに
よって共有されるリソースへのアクセスを制御し、初期化命令を
同期するためにロックするために使用されます。 

mtb-example-psoc6-dual-cpu-
ipc-pipes 

この例は、プロセッサ間通信 (IPC) ドライバを使用して PSoC 6 
MCUにメッセージパイプを実装する方法を示します。パイプは、
CPU間でメッセージを送信するために使用されます。 

PSoC Creatorコンポーネント データシート 
Interrupt ハードウェア信号から CPU割込み生成をサポート 
デバイス資料 
PSoC 6 MCU Datasheet PSoC 6 Technical Reference Manual 

https://community.cypress.com/docs/DOC-14644
http://www.cypress.com/an221774
http://www.cypress.com/AN210781
http://www.cypress.com/an217666
http://www.cypress.com/an219434
http://www.cypress.com/ce216795
https://www.cypress.com/documentation/code-examples/ce223820-psoc-6-mcu-ipc-pipes?source=search&keywords=IPC&cat=software_tools
https://www.cypress.com/documentation/code-examples/ce223549-psoc-6-mcu-ipc-semaphore?source=search&keywords=IPC&cat=software_tools
https://www.cypress.com/documentation/code-examples/ce226306-psoc-6-mcu-power-measurements?source=search&keywords=Power&cat=software_tools
https://github.com/cypresssemiconductorco/mtb-example-psoc6-dual-cpu-empty-app
https://github.com/cypresssemiconductorco/mtb-example-psoc6-dual-cpu-empty-app
https://github.com/cypresssemiconductorco/mtb-example-psoc6-dual-cpu-ipc-sema
https://github.com/cypresssemiconductorco/mtb-example-psoc6-dual-cpu-ipc-sema
https://github.com/cypresssemiconductorco/mtb-example-psoc6-dual-cpu-ipc-pipes
https://github.com/cypresssemiconductorco/mtb-example-psoc6-dual-cpu-ipc-pipes
http://www.cypress.com/go/comp_SysInt_PDL
https://www.cypress.com/search/all?f%5B0%5D=meta_type%3Atechnical_documents&f%5B1%5D=resource_meta_type%3A575&f%5B2%5D=field_related_products%3A114026
https://www.cypress.com/search/all/PSoC%206%20Technical%20Reference%20Manual?f%5B0%5D=meta_type%3Atechnical_documents&f%5B1%5D=resource_meta_type%3A583
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開発キット資料 
CY8CKIT-062-BLE PSoC 6 Bluetooth LEパイオニアキット 
CY8CKIT-062-WiFi-BT PSoC 6 WiFi-BTパイオニアキット 
CY8CKIT-062S2-43012 PSoC 62S2 Wi-Fi BTパイオニアキット 
CY8CPROTO-063-BLE PSoC 6 Bluetooth LEプロトタイプキット 
CY8CPROTO-062-4343W PSoC 6 Wi-Fiプロトタイプキット 
CY8CPROTO-062S3-4343W PSoC 62S3 Wi-Fi BTプロトタイプキット 
CYW9P62S1-43438EVB-01 PSoC 62S1 Wi-Fi BTパイオニアキット 
CYW9P62S1-43012EVB-01 PSoC 62S1 Wi-Fi BTパイオニアキット 
ツール資料 

ModusToolbox IDE 

ModusToolboxソフトウェアは IoTデザイナーのための開発を簡単
にします。使いやすいツールと、Windows, macOS, および Linux用
の使い慣れたマイクロコントローラ (MCU) 統合開発環境 (IDE) を提
供します。 

PSoC Creator 

PSoC Creatorは PSoCデバイスのハードウェアとファームウェアの
同時編集、コンパイルおよびデバッグを可能にします。アプリケ
ーションは、回路図キャプチャと 150以上の事前検証済みのプロ
ダクション対応ペリフェラル コンポーネントを使用して作成され
ます。クイックスタートガイドとユーザーガイドのダウンロード
タブを参照してください。 

Peripheral Driver Library (PDL) 

PSoC Creator 4.3によってインストールされ、GitHubから利用でき
ます。https://github.com/cypresssemiconductorco/psoc6pdlにア
クセスしてください。PSoC Creatorの場合は、<PDL install 
folder>\docでユーザーガイドと APIリファレンスを確認してくだ
さい。 

Hardware Abstraction Layer (HAL) 
GitHubからのみ利用できます。 
https://github.com/cypresssemiconductorco/psoc6halにアクセス
してください。 

 

著者について 
氏名: Mark Ainsworth 
役職: シニア アプリケーション エンジニア主任 
経歴: Mark Ainsworthは、シラキュース大学のコンピュータ工学の学士号および

ワシントン大学の修士号を取得しました。また、組込みシステムの設計
と構築に長く従事しています。 

 

http://www.cypress.com/CY8CKIT-062-BLE
http://www.cypress.com/documentation/development-kitsboards/psoc-6-wifi-bt-pioneer-kit
https://www.cypress.com/CY8CKIT-062S2-43012
http://www.cypress.com/documentation/development-kitsboards/psoc-6-ble-prototyping-kit
http://www.cypress.com/documentation/development-kitsboards/psoc-6-wi-fi-prototyping-kit?source=search&cat=software_tools
https://www.cypress.com/CY8CPROTO-062S3-4343W
https://www.cypress.com/CYW9P62S1-43438EVB-01
https://www.cypress.com/CYW9P62S1-43012EVB-01
http://www.cypress.com/products/modustoolbox-software-environment
http://www.cypress.com/products/psoc-creator-integrated-design-environment-ide
http://www.cypress.com/documentation/software-and-drivers/peripheral-driver-library-pdl
https://github.com/cypresssemiconductorco/psoc6pdl
https://github.com/cypresssemiconductorco/psoc6hal
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重要事項 
本文書に記載された情報は、いかなる場合も、 
条件または特性の保証とみなされるものではあ 
りません（「品質の保証」）。本文に記された 
一切の事例、手引き、もしくは一般的価値、お 
よび／または本製品の用途に関する一切の情報 
に関し、インフィニオンテクノロジーズ（以 
下、「インフィニオン」）はここに、第三者の 
知的所有権の不侵害の保証を含むがこれに限ら 
ず、あらゆる種類の一切の保証および責任を否 
定いたします。 
 
さらに、本文書に記載された一切の情報は、お 
客様の用途におけるお客様の製品およびインフ 
ィニオン製品の一切の使用に関し、本文書に記 
載された義務ならびに一切の関連する法的要 
件、規範、および基準をお客様が遵守すること 
を条件としています。 
 
本文書に含まれるデータは、技術的訓練を受け 
た従業員のみを対象としています。本製品の対 
象用途への適合性、およびこれら用途に関連し 
て本文書に記載された製品情報の完全性につい 
ての評価は、お客様の技術部門の責任にて実施 
してください。 

 
本製品、技術、納品条件、および価格について 
の詳しい情報は、インフィニオンの最寄りの営 
業 所 ま で お 問 い 合 わ せ く だ さ い 
 (www.infineon.com). 
 

警告事項 
技術的要件に伴い、製品には危険物質が含まれ 
る可能性があります。当該種別の詳細について 
は、インフィニオンの最寄りの営業所までお問 
い合わせください。 
インフィニオンの正式代表者が署名した書面を 
通じ、インフィニオンによる明示の承認が存在 
する場合を除き、インフィニオンの製品は、当 
該製品の障害またはその使用に関する一切の結 
果が、合理的に人的傷害を招く恐れのある一切 
の用途に使用することはできないこと予めご了 
承ください。 
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